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Confidentiel
• La copie de données de séquences musicales disponibles dans le commerce et/ou de fichiers audionumériques, 

graphiques ou vidéo  est strictement interdite, sauf pour un usage personnel.

• Les copyrights du logiciel et de ce mode d'emploi sont la propriété exclusive de Yamaha Corporation.

• Toute copie des logiciels ou de ce mode d’emploi en tout ou en partie, par quelque moyen que ce soit, est 
expressément interdite sans le consentement écrit du fabricant.

• Yamaha n'offre aucune garantie quant à l'usage des logiciels ou de la documentation et ne peut être tenu pour 
responsable des résultats de cet usage.

• Les affichages illustrant ce mode d'emploi sont donnés à titre informatif et peuvent être légèrement différents des 
affichages apparaissant sur votre ordinateur.

• Windows est une marque déposée de Microsoft® Corporation aux États-Unis et dans d'autres pays.

• Apple, Mac et Macintosh sont des marques d’Apple Inc., déposées aux États-Unis et dans d’autres pays.

• Les noms de sociétés et de produits qui apparaissent dans ce mode d'emploi sont des marques commerciales ou 
des marques déposées appartenant à leurs propriétaires respectifs.

Ce mode d'emploi part du principe que vous êtes déjà habitué aux opérations liées à l'environnement Windows/Mac. 
Si tel n'est pas le cas, veuillez vous reporter au mode d'emploi fourni avec votre logiciel Windows/Mac avant d'utiliser 
cette application.
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Qu'est-ce qu' « Audio Phraser » ?

Audio Phraser est un logiciel qui vous permet de créer vos propres styles audio (partie audio 
uniquement) à partir des fichiers audio (wav) de votre choix. Lorsque vous créez un style audio sous 
ce logiciel, vous pouvez affecter les données audio souhaitées aux différentes sections de style 
(Intro 1-3, Main A-D, Fill In A-D, Break, Ending 1-3) en tant que partie audio.

À propos de la partie audio
Une partie audio est une partie du style audio, qui constitue lui-même un type de style spécifique. Elle est composée de données 
de forme d'onde ou d'autres données dont l'exécution s'effectue en allongeant le temps de reproduction en temps réel. Lors de la 
reproduction de la partie audio sur l'instrument, la technologie Time Stretch (Extension de temps) permet à la forme d'onde de 
suivre les changements de tempo sans en modifier la hauteur de ton en cours d'exécution, de sorte que la partie audio reste 
synchronisée sur le tempo. La partie audio ne réagit pas aux entrées d'accords lorsqu'elle s'exécute sur l'instrument (en d'autres 
termes, sa hauteur de ton n'est pas modifiée).

Présentation du style audio

NOTE
• Le fichier de style exporté peut uniquement être utilisé sur un instrument prenant en charge les styles audio ainsi que le format SFF GE. 

• Le fichier de style exporté peut être modifié à l'aide la fonction Style Creator de l'instrument prenant en charge les styles audio, pour ce 
qui concerne les parties autres que la partie audio.

Audio Phraser

Style audio
(Comprend uniquement la partie audio)

WAV

Importer Exporter

Phrase 2

Phrase 1

Pad

Accord 2

Accord 1

Basse

Rhythme 2

Rhythme 1

Partie audio

La partie audio est créée par ce logiciel. En cas 
d'exportation, les données de forme d'onde affectées 
sont enregistrées, après traitement approprié, comme 
étant intégrées à cette partie.

Partie 
principale A

Partie principale B

Variation rythmique

Introduction

Coda 2

Coda 3

Parties MIDI. En cas d'exportation, ces données 
seront enregistrées en tant que données vierges 
par ce logiciel.
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Éléments et fonctions de l'écran

Fenêtre principale

qMenu
File (Fichier) : permet de créer, d'enregistrer ou de charger un projet de style audio en exportant le projet vers un fichier de 

style audio.
Edit (Édition) : permet d'annuler ou de rétablir l'opération qui précède immédiatement.
Setting (Réglage) : permet de régler le périphérique de sortie audio utilisé pour l'écoute.
Help (Aide) : permet d'afficher les informations relatives au logiciel, telles que le numéro de version.

wNom de projet
Affiche le nom de projet en cours d'édition.

eTempo et type de mesure
Affichent respectivement le tempo et le type de mesure de l'ensemble du style appliqué au projet. Ces valeurs peuvent être 
modifiées en saisissant directement les chiffres concernés.

[], [] : modifie le tempo par incréments.
[/2] (*): analyse à nouveau le tempo du fichier audio (**) en réduisant sa valeur actuelle de moitié ; réduit également la 

valeur du tempo de style de moitié par rapport à celle de l'original.
[x2] (*) : analyse à nouveau le tempo du fichier audio (**) en redoublant sa valeur actuelle ; augmente également la valeur 

du tempo de style de deux fois par rapport à celle de l'original.
* Ces touches ne sont disponibles que lorsqu'un fichier audio unique est affecté à l'ensemble du projet et que la case d'option « Manual » (Manuel) 

n'est pas cochée dans la zone d'édition de section.
** Tempo du fichier audio : tempo résultant de l'analyse du fichier audio. Le tempo est analysé lorsque le fichier audio est importé ou en cas 

d'exécution de l'opération en [/2] ou en [x2]. Il s'agit d'un paramètre masqué, ce qui signifie que sa valeur n'est pas affichée directement. Pour plus 
de détails, reportez-vous à la page suivante.

rZone des opérations liées à l'écoute
Cette zone vous permet d'effectuer des opérations relatives à l'écoute. Pour plus de détails, reportez-vous aux pages suivantes.

AVIS
Toute modification du type de mesure entraîne la réinitialisation des réglages de toutes les sections. 
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tZone d'édition de section
Vous pouvez sélectionner ici la section à éditer et lui attribuer la forme d'onde souhaitée. Pour plus de détails, reportez-vous 
aux pages suivantes.

Zone des opérations liées à l'écoute dans la fenêtre principale

[]/[] : démarre/arrête la reproduction de l'écoute des données audio affectées à la section en cours d'édition. 
La reproduction se poursuit en boucle jusqu'à ce que vous l'arrêtiez.

Curseur de volume : règle le volume de la reproduction de l'écoute.

Time Stretch (Extension de temps) : lorsque cette case d'option est cochée, vous pouvez écouter les données audio 
soumises à l'extension de temps telles qu'elles retentissent lors de leur exportation vers un style donné selon le réglage 
actuellement sélectionné. Si cette case n'est pas cochée, les données audio seront reproduites telles quelles.

Click (*) (Clic) : lorsque cette case d'option est cochée, un clic de métronome est audible pendant la reproduction de 
l'écoute. Le volume sonore du clic de métronome est fixe.
* Cette case d'option n'est disponible que lorsqu'un fichier audio unique est affecté à l'ensemble du projet et que la case « Manual » n'est pas cochée dans la 

zone d'édition de section.

Extension du temps de reproduction — Effets exercés sur la forme d'onde par les 
différences de tempo introduites dans le fichier audio et le style en cours d'exportation
Le fichier audio est automatiquement analysé lors de son importation, et une valeur estimative est alors attribuée 
à son tempo. La valeur de tempo des données audio ainsi calculée ne s'affiche pas sous forme numérique, mais elle 
est prise en compte dans l'affichage des temps à l'écran et dans la valeur initiale du tempo de style du projet. 
Le tempo de fichier audio et le tempo de style servent à calculer l'extension de temps lors de l'exportation d'un projet 
vers un fichier de style.
En cas d'exportation d'un projet vers un fichier de style, les données audio affectées aux différentes sections sont 
soumises à une extension de temps de sorte qu'elles correspondent au tempo de style. Les données sont ensuite 
exportées au titre de données de forme d'onde de la section.
Par exemple, si le tempo du fichier audio est de 120 et celui du style de 180, l'extension de temps est appliquée de 
sorte à augmenter la valeur du tempo de 150 % par rapport à la vitesse d'exécution des données audio d'origine. 
Les données ainsi paramétrées sont alors enregistrées et exportées.

NOTE
• Un fichier d'analyse (.awi) est créé sur le même emplacement que le fichier audio importé.

• La plage du ratio d'extension de temps varie de 50 à 200 %. Si le ratio des réglages obtenus dépasse cette plage de valeurs, 
le projet ne pourra pas être exporté vers le fichier de style.

• Le temps de reproduction calculé d'après le tempo de style, le type de mesure, et la valeur du paramètre « Bar » (nombre de 
mesures) apparaît sous « Section length » (Longueur de section) sur la barre d'état.

• Le temps de reproduction original de la plage sélectionnée pour le fichier audio est affiché sous « Wave length » (Longueur d'onde) 
dans la barre d'état.

• Le ratio de l'extension de temps utilisé pour adapter les données audio sélectionnées à la valeur de « Section length » s'affiche 
sous «Time stretch » (Extension de temps) dans la barre d'état.

NOTE
• L'extension de temps est le processus de modification de la vitesse ou de la durée d'un signal audio sans en modifier la hauteur 

de ton.

• Les données audio affectées à la section concernée sont soumises à l'extension de temps de sorte qu'elles correspondent à la 
valeur spécifiée sous « Section length » lorsque le projet est exporté vers un fichier de style audio.

• Pendant l'écoute des résultats de la reproduction soumise à l'extension de temps, une fenêtre contextuelle dédiée s'affiche et il n'est 
plus possible d'effectuer les opérations d'édition pendant l'écoute. 
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Zone d'édition de section de la fenêtre principale

q Section : affiche le nom de la section en cours d'édition. Vous pouvez également sélectionner la section à éditer via ce 
paramètre.

wWave file (Fichier Wave) : affiche le nom du fichier audio qui est affecté à la section en cours d'édition. Vous pouvez 
également modifier le fichier audio affecté.
[+]: permet d'affecter un nouveau fichier audio à la section (Importer).
[-]: permet de supprimer l'affectation actuelle du fichier audio.

eManual (Manuel) : lorsque cette case est cochée, vous pouvez saisir manuellement tous les réglages liés à l'affectation 
de forme d'onde de la section.

rZone de forme d'onde : affiche la forme d'onde du fichier audio affecté ainsi que la plage attribuée à la section en 
cours d'édition. Vous pouvez sélectionner la plage de l'affectation à l'aide de la souris.
La plage affectée à la section s'affiche en jaune. Lorsque la case « Manual » n'est pas cochée, la grille des temps établie en 
fonction de l'analyse s'affiche sur la forme d'onde. Si un fichier audio est affecté à d'autres sections, les plages relatives à ces 
sections apparaîtront dans le bas de la zone.

t Start time (Heure de début) / End time (Heure de fin) : affichent respectivement les temps de début et de fin 
de la plage affectée à la forme d'onde dans le fichier audio. Vous pouvez changer ces paramètres en saisissant directement de 
nouvelles valeurs.

NOTE
• Lorsque cette case est cochée, certains changement sont également apportés à l'écran : la grille des temps (résultant de l'analyse) 

ne s'affiche pas dans la zone de forme d'onde et certains éléments liés aux opérations sont désactivés, etc.
• Lorsque deux fichiers audio ou plus sont utilisés dans un projet, les cases d'option « Manual » de toutes les sections sont 

automatiquement sélectionnées.

NOTE
Si vous maintenez la touche Maj enfoncée lorsque le curseur de la souris est positionné dans la zone de forme d'onde, vous pourrez 
utiliser la souris pour effectuer d'autres opérations sur la plage affichée en jaune. Pour déplacer la plage, il est nécessaire de placer le 
curseur sur celle-ci. Pour en modifier les limites, il faut placer le curseur à gauche ou à droite de la plage.

NOTE
Si la case « Manual » n'est pas cochée, les paramètres « Start time » et « End time » seront automatiquement ajustés selon la grille 
de temps la plus proche possible de la valeur d'entrée.
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yBarre d'état
Affiche les informations ci-dessous relatives à la section en cours d'édition. Si certains réglages pourraient entraîner l'échec 
de l'exportation, un message supplémentaire s'affichera en rouge pour le signaler.
Section length : indique le temps de reproduction de la section, lorsque le style exporté est reproduit sur l'instrument sans 

modification de tempo. Ceci est calculé à partir de la valeur du tempo, du type de mesure et du paramètre « Bar » 
(nombre de mesures).

Wave length : indique le temps de reproduction d'origine de la plage sélectionnée du fichier audio.
Time Stretch : indique le ratio de l'extension de temps appliqué de sorte que les données audio sélectionnées correspondent 

à la valeur spécifiée sous « Section length » lorsque le projet est exporté vers un fichier de style audio. Lorsque ce 
paramètre est réglé sur 50 %, la vitesse de reproduction du son est réduite  de moitié. Lorsqu'il est réglé sur 200 %, 
la vitesse de reproduction du son est redoublée.

Si les données audio ne peuvent pas être exportées en raison d'un ratio non valide, ce dernier apparaîtra en rouge.

uBar : affiche le nombre de barres (mesures) estimées pour la plage sélectionnée. Ce paramètre est identique à « Pattern 
Length » (Longueur de motif) applicable à la section sous la fonction Style Creator de l'instrument. Si la case « Manual » est 
cochée, vous pourrez saisir la valeur manuellement. Chaque type de section dispose d'une limite supérieure pour la valeur du 
paramètre « Bar », de sorte que la projet ne pourra pas être exporté si la valeur de ce paramètre dépasse la limite fixée. Pour 
plus de détails sur les limitations de valeur, reportez-vous aux explications fournies sous « Limite supérieure de la valeur de 
Bar applicable aux différentes sections » à la page suivante.

iFade (Fondu) : lorsque cette case est cochée, l'ouverture et la fermeture par fondu sonore seront appliquées lors de 
l'exportation de la plage sélectionnée. Essayez activer ce paramètre en cas de bruit perceptible autour des temps de début et 
de fin d'une section exportée lors de sa reproduction sur l'instrument.

o Shift/Unshift Beat Position (Position de temps décalée/non décalée) : règle le résultat de la détection de 
temps en échangeant la reconnaissance des temps frappés et des temps bas. Ce paramètre est disponible uniquement lorsque 
la case « Manual » n'est pas cochée.

Sélection de la plage d'affectation — différence entre la désactivation et l'activation 
du paramètre « Manuel »

Lorsque la case d'option « Manual » n'est PAS cochée (mode semi-automatique) :
Le résultat issu de l'analyse du fichier audio est utilisé.
• La plage de la forme d'onde est sélectionnée en fonction de la position des temps déterminée par les résultats de 

l'analyse. 
• La valeur de « Bar » est automatiquement calculée à partir du tempo du fichier audio résultant de l'analyse et de la 

plage sélectionnée.
• Le ratio de l'extension de temps est presque toujours constant, sauf en cas de modification du tempo de style par la 

saisie directe de nouvelles valeurs numériques.

Lorsque la case d'option « Manual » est cochée (manuellement) :
Le résultat issu de l'analyse du fichier audio n'est PAS utilisé.
• La plage souhaitée de la forme d'onde peut être sélectionnée manuellement.
• La valeur de « Bar » est saisie manuellement, qui spécifie le nombre de mesures estimées pour la plage 

sélectionnée, en fonction du type de mesure actuel. Le nombre de temps dans la plage sélectionnée est calculé en 
fonction de la valeur de « Bar » et du type de mesure. Enfin, le paramètre « Section length » est calculé à l'aide du 
tempo du style ajouté.

• Le ratio de l'extension de temps varie selon les réglages.

Ce qui se produit lorsque la forme d'onde affectée à une section est trop longue
Dans un style audio, les informations audio sont ajoutées à la forme d'onde afin d'exécuter le traitement de 
l'extension de temps susceptible de maintenir la qualité audio optimale en cas de reproduction sur l'instrument. Si le 
temps de reproduction de la forme d'onde affectée à une section est trop long, il se peut qu'il n'y ait pas assez 
d'informations audio à ajouter et un message d'avertissement s'affiche alors lorsque le projet est exporté vers le 
fichier de style audio. Dans ce cas, une dégradation de la qualité du son peut se produire lors de la reproduction d'un 
style exporté sur l'instrument. Pour cette raison, vous devriez maintenir la forme d'onde affectée sur la longueur 
minimum requise pour chaque section.
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Limite supérieure de la valeur de Bar applicable aux différentes sections
La valeur du paramètre Bar dispose d'une limite supérieure pour chaque type de section. Si la valeur d'une ou de 
plusieurs sections dépasse la limite autorisée, le projet ne pourra pas être exporté vers un style audio. 
Lors de la modification d'une section, l'opération n'est pas astreinte à la limite supérieure, mais un message s'affiche 
dans la barre d'état lorsque la limite supérieure est dépassée. 

Les limites supérieures des différentes sections sont comme suit :

Sections Limite supérieure de la valeur de Bar

Main A-D, Intro 1-4, Ending 1-4 32

Fill In A-D, Break 1
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Création d'un nouveau projet et importation d'un fichier audio

1. Cliquez sur « File  New Audio Style Project » (Nouveau projet de style audio).

2. Cliquez sur la touche Wave file: [+] (Fichier wave : [+]).

3. Sélectionnez le fichier audio (.wav). souhaité.
Format de fichier compatible : format WAV ; taux d'échantillonnage de 44,1 kHz, résolution de 16 bits, stéréo

4. Cliquez sur « File  Save Project File » (Enregistrer le fichier de projet) pour 
sauvegarder le projet.

Chargement de projet et modification des sections

1. Cliquez sur « File  Open Audio Style Project » (Ouvrir le projet de style audio).

2. Sélectionnez le fichier de projet souhaité.

3. Modifiez les sections selon vos besoins.
Pour obtenir des instructions sur la manière de modifier les sections, reportez-vous au paragraphe « Éléments et fonctions 
de l'écran ».  

4. Cliquez sur « File  Save Project File » pour sauvegarder le projet.
Si vous souhaitez enregistrer le projet modifié sous un autre nom, cliquez sur « File  Save Project File as ... » 
(Enregistrer le fichier de projet sous) pour sauvegarder le projet portant le nom souhaité.

NOTE
Un fichier d'analyse (.awi) est créé sur le même emplacement que le fichier audio importé.
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Exportation du projet vers un fichier de style audio

1. Cliquez sur « File  Open Audio Style Project ».

2. Sélectionnez le fichier de projet souhaité.

3. Cliquez sur « File  Export as the Style File » (Exporter sous forme de fichier de 
style) pour exporter le projet.

4. Saisissez le nom du fichier de style souhaité, puis cliquez sur la touche [Save] 
(Enregistrer).
Le processus d'exportation est exécuté et un message s'affiche lorsque l'opération est terminée.

Installation d'un fichier de style audio exporté (.aus) vers l'instrument
Il existe deux méthodes pour installer et reproduire le style audio exporté sur votre instrument.

(A) Importez les données dans Yamaha Expansion Manager puis stockez-les sur l'instrument en tant que données 
originales d'Expansion Pack.

(B) Enregistrez le fichier de style audio (.aus) directement sur un lecteur flash USB et connectez ce dernier 
à l'instrument.

La méthode (a) est disponible pour un instrument pris en charge par Yamaha Expansion Manager et pourra être 
utilisée sur les modèles compatibles avec le style audio. Pour déterminer si l'instrument utilisé est compatible ou non 
avec le style audio, reportez-vous à son mode d'emploi.

La méthode (b) sera disponible uniquement sur la version 1.20 ou ultérieure du microprogramme du Genos, à partir 
d'avril 2018. 
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